# RootsMagic ver 7 – Table of Contents

## Table of Contents

1 – FROM SCRATCH ........................................................................................................... 5     
   A. Creating a New family database ................................................................................... 5  
   B. Adding People ............................................................................................................... 5  
       A-1 Edit Individual ........................................................................................................... 6  
           A-1-1 Add a fact alt + a ............................................................................................. 6  
           A-1-2 Delete fact alt + d ............................................................................................. 6  
           A-1-3 Address alt + r .................................................................................................. 7  
           A-1-4 Media alt + m ..................................................................................................... 7  
           A-1-5 To Do alt + t ....................................................................................................... 7  
           A-1-6 Research Log alt + e .......................................................................................... 7  
           A-1-7 Notes .................................................................................................................. 8  
               A-1-7-1 Entering Notes ............................................................................................ 8  
               A-1-7-2 Editing Text ................................................................................................ 8  
               A-1-7-3 Moving Paragraphs ..................................................................................... 8  
       A-2 Sourcing alt + s ......................................................................................................... 9  
           A-2-1 Add new source alt + a ..................................................................................... 9  
           A-2-1-1 Free Form ........................................................................................................ 9  
           A-2-1-2 Source Templates ............................................................................................ 9  
           A-2-2 Cite existing source alt + c ................................................................................ 10  
           A-2-3 Delete alt + d ....................................................................................................... 10  
           A-2-4 Memorize alt + m ............................................................................................... 10  
           A-2-5 Paste alt + p ....................................................................................................... 10  

**Sourcing Tips** .................................................................................................................. 10  
   A-3 Share this fact alt + h ............................................................................................... 11  
       A-3-1 Add a person alt + a ............................................................................................ 11  
       A-3-2 Add multiple people alt +m ............................................................................... 11  
   C. Adding people through facts ....................................................................................... 12  
   D. Adding people through family view ............................................................................ 12  
   E. Adding people from the add menu bar alt + a .............................................................. 13  
       Adding Individuals alt + i ............................................................................................. 13  
   F. Adding Spouses alt + s ................................................................................................. 13  
       Adding Children ............................................................................................................ 14  
       Adding Parents ............................................................................................................. 14  
   Add a Person from the icons ............................................................................................ 14  

2 – DATA ENTRY ROUTINE .................................................................................................. 15  

---

*RootsMagic ver 7 – Table of Contents*

**Table of Contents**

1 – FROM SCRATCH ........................................................................................................... 5

A. Creating a New family database ................................................................................... 5

B. Adding People ............................................................................................................... 5

A-1 Edit Individual ........................................................................................................... 6

A-1-1 Add a fact alt + a ............................................................................................. 6

A-1-2 Delete fact alt + d ............................................................................................. 6

A-1-3 Address alt + r .................................................................................................. 7

A-1-4 Media alt + m ..................................................................................................... 7

A-1-5 To Do alt + t ....................................................................................................... 7

A-1-6 Research Log alt + e .......................................................................................... 7

A-1-7 Notes .................................................................................................................. 8

A-1-7-1 Entering Notes ............................................................................................ 8

A-1-7-2 Editing Text .................................................................................................... 8

A-1-7-3 Moving Paragraphs ......................................................................................... 8

A-2 Sourcing alt + s ......................................................................................................... 9

A-2-1 Add new source alt + a ..................................................................................... 9

A-2-1-1 Free Form ........................................................................................................ 9

A-2-1-2 Source Templates ............................................................................................ 9

A-2-2 Cite existing source alt + c ................................................................................ 10

A-2-3 Delete alt + d ....................................................................................................... 10

A-2-4 Memorize alt + m ............................................................................................... 10

A-2-5 Paste alt + p ....................................................................................................... 10

**Sourcing Tips** .................................................................................................................. 10

A-3 Share this fact alt + h ............................................................................................... 11

A-3-1 Add a person alt + a ............................................................................................ 11

A-3-2 Add multiple people alt +m ............................................................................... 11

C. Adding people through facts ....................................................................................... 12

D. Adding people through family view ............................................................................ 12

E. Adding people from the add menu bar alt + a .............................................................. 13

Adding Individuals alt + i ............................................................................................. 13

F. Adding Spouses alt + s ................................................................................................. 13

Adding Children ............................................................................................................ 14

Adding Parents ............................................................................................................. 14

Add a Person from the icons ............................................................................................ 14

2 – DATA ENTRY ROUTINE .................................................................................................. 15
RootsMagic ver 7 – Table of Contents

A. Entering Your Information..............................................................15

B. Data Entry Tips ..............................................................................15

C. The Routine .................................................................................15

   C-1 Adding new people.................................................................15

   C-2 Adding new facts to already existing people .........................16

   C-3 Adding shared facts.................................................................16

3 – SOME ICONS.............................................................................17

A. Explorer .......................................................................................17

   A-1 Prior alt + i ............................................................................17

   A-2 Name Find alt + m ...............................................................17

   A-3 Next alt + x .........................................................................18

   A-4 Individual Edit alt + e ........................................................18

   A-5 Family Members Go to selected person alt + g ....................18

   A-6 Select alt + s .......................................................................18

B. Manual Merge ...............................................................................18

C. Edit Multimedia ............................................................................18

   C-1 Person Media alt + p .............................................................18

       C-1-1 Add new media alt + a .................................................19

       C-1-1-1 Adding multiple images at a time .........................20

       C-1-2 Add from gallery alt + g .............................................20

       C-1-3 View/Edit alt + v .........................................................20

       C-1-4 Properties alt + e .........................................................21

           C-1-4-1 Tag media ..............................................................21

           C-1-4-2 Edit tag ................................................................21

           C-1-4-3 Delete tag ..............................................................21

       C-1-5 Remove Media alt + r ....................................................21

       C-1-6 Print .............................................................................21

       C-1-7 Tools ............................................................................21

   C-2 Media gallery alt + M will take time to open .........................22

       C-2-1 Add new media alt + a .................................................22

       C-2-2 View/Edit alt + v .........................................................22

       C-2-3 Properties alt + e ........................................................22

       C-2-4 Remove media alt + r ...................................................22

       C-2-5 Tools alt + t .................................................................22

4 – The Menu Bar ............................................................................23

A. Edit alt + e ..................................................................................23
RootsMagic ver 7 – Table of Contents

A-1 Person alt + p ........................................................................................................... 23
A-2 Delete alt +d ........................................................................................................... 23
A-3 Unlink alt +u ........................................................................................................... 23
A-4 Rearrange alt +t ........................................................................................................ 23
A-5 Swap Husband and Wife alt +s ........................................................................ 23

B. Setting default options .......................................................................................... 24

5 – The Views ........................................................................................................... 25

A. Pedigree ................................................................................................................. 25
B. Family ..................................................................................................................... 25
C. Descendants .......................................................................................................... 26
D. People ..................................................................................................................... 26
E. WebSearch ............................................................................................................. 26
F. Timeline .................................................................................................................. 27
  F-1 Options ............................................................................................................... 27

6 – MEDIA ............................................................................................................... 28

A. How media works within RootsMagic ................................................................... 28
B. Image Naming Tips ............................................................................................... 28
C. Filing System Tips ................................................................................................. 28
D. The Media Gallery ................................................................................................. 29

7- MISCELLANEOUS .............................................................................................. 30

Root Person ............................................................................................................... 30
  Go to Root Person .................................................................................................... 30
  Setting Root Person ................................................................................................. 30
Customizing add person form .................................................................................. 30
Adding new fact types ............................................................................................... 30
Children out of order ............................................................................................... 31
Multiple Spouses out of order ................................................................................ 31
Ah-oh ......................................................................................................................... 31

Take Care of your Database ..................................................................................... 32

8 – WEB HINTS AND WEB SEARCH ..................................................................... 33

A. WebHints ............................................................................................................... 33
  A-1 Familysearch.org ............................................................................................. 33
  A-2 Findmypast.com .............................................................................................. 34
A-3 My Heritage.com ................................................................................................. 35
B. WebSearch ............................................................................................................. 35
C. Manage different search providers ....................................................................... 35
## Table of Contents

C-1 Use External Browser .................................................................................................................. 35  
C-2 Use Auto-Search .......................................................................................................................... 35  
D. Saving in Chrome ............................................................................................................................ 36  
E. Saving in Firefox ............................................................................................................................... 36  
F. Saving in Edge .................................................................................................................................. 36  
G. Saving in Internet Explorer ............................................................................................................... 37  
9 – KEYBOARD SHORTCUTS ............................................................................................................ 38  
A. General Keyboard Shortcuts ........................................................................................................... 38  
B. Windows Keyboard Shortcuts ......................................................................................................... 38  
C. RootsMagic Keyboard Shortcuts ..................................................................................................... 40
1 – FROM SCRATCH

IN THIS SECTION, YOU WILL LEARN ABOUT:

A. Creating a New family database
B. Adding people
C. Adding people through facts
D. Adding people through family view
E. Adding people from the add menu bar
F. Adding people from the icons

A. Creating a New family database

All your information does not have to be in one file. From the file menu select new or alt + F; Ctrl + n.

Give your file a name. Navigate to where you want to store the file. Complete the rest of the options and click the Ok button.

A blank pedigree page will open as it is the default unless you changed it to something else. The new file will open in the pedigree view as that is the default view. See page 24 to set default view. See page 25 for pedigree view.

B. Adding People

NOTE: Underlined letters used with the alt key will do what the link is for.

For a new tree click on “click to add a person”. This box will open. This same box, or a similar one, opens for adding new people no matter where you are entering them from. There are multiple ways to add new people. You can add them from the Add people icon. See page 14. You can add them from the different views by clicking on the Click to add….. See page 25. OR add in the menu bar. See page 13. You can add them as you are adding spouses, children, parents

NOTE: There are fields for Given and Surnames. Prefixes are Dr, Rev, Maj, etc. Suffixes are Jr, Sr, etc. Places format is Town, County, State, Country. You can add different facts to this form by clicking on Customize this form. See page 31.

Complete as much as you can and click OK or alt + o.
A-1 Edit Individual

A-1-1 Add a fact alt + a

- Just start typing fact name OR
- Design new fact type alt + n. See page 31.
- Edit alt + e.
- Delete alt + d.
- Print alt + p.

NOTE: if you chose a fact that is 'shared' the select spouse box will open. (see page 13) You can choose someone already in your database or add a new spouse.

A-1-2 Delete fact alt + d

Will delete the selected fact from the persons edit page.
A-1-3 Address alt + r
A place to store up to two addresses for your family members.

A-1-4 Media alt + m
This is for linking to the individual, not a source. See page 19.

A-1-5 To Do alt + t
Utilize this tool to add reminders and to dos to the individual or their family unit.

➤ Add task alt + a - Can be for a person or a family.
➤ Edit task alt + e - opens the selected task.
➤ Delete task alt + d – deletes the selected task.
➤ Print alt + p – prints the tasks.

A-1-6 Research Log alt + e
You can, by individual, keep track of where you have looked successfully or not.
➤ Add research log alt + a
➤ Edit research log alt + e
➤ Delete research log alt + d
➤ Print alt + P
A-1-7 Notes

The Notes area box allows you to enter comments, stories, etc. that do not fit elsewhere in the available program categories.

A-1-7-1 Entering Notes

This section shows you how easy it is to enter notes. You'll learn how to enter text and make corrections and to rearrange the order of paragraphs.

- Type your desired text.
  - If you make a mistake: Use the left arrow key to move the cursor back to the left and use Backspace to delete the incorrect characters.
  - The Backspace key deletes characters as it moves the cursor to the left. If you need to move the cursor back to the right, press the right arrow key.
- Pressing Enter moves you to the next line.
- If a word doesn't fit at the end of a line, RootsMagic automatically moves it to the beginning of the next line. You should only press Enter when you reach the end of a paragraph.
- Different monitors can fit different amounts of text on each line, so don't worry if your screen doesn't look the same as others.
- Tool bar:
  - You can use bold, underline, italics
  - Character Map has symbols
  - Spell Check
  - Thesaurus
    - Find and Replace

A-1-7-2 Editing Text

You may want to change your notes after entering them. In the following steps, you'll make a simple textual change and see how RootsMagic automatically reformats your notes for you.

- To insert a word or words in already written text, move the mouse in front of the word that will go after the inserted word and then click the left mouse button so that the flashing cursor appears in front of the word.
- Type the word you want to insert.
- To delete a word or words press the Delete key until all of the word is deleted OR move your mouse to the front of the word and while holding down the mouse button, drag it over the word or words until they are highlighted. You can then hit the delete key once and the entire word or words will be deleted.
- RootsMagic reformats each paragraph for you automatically as you insert or delete words.

A-1-7-3 Moving Paragraphs

If the paragraphs are in the wrong order you can rearrange them.

- Move the mouse to the beginning of the paragraph to be moved.
- Press and hold your primary mouse button and then drag the mouse down to the end of the paragraph. This is called "clicking and dragging." Notice that characters are highlighted, or selected, as you drag over them.
RootsMagic ver 7 – 1 – From Scratch

- Release the mouse button when you’re at the end of the paragraph, being careful not to press another key. The paragraph should be completely highlighted.
- Press Ctrl + X, or, right-click and select cut from the menu. The text will be removed. The paragraph disappears from the screen, but it’s not gone. It’s in a temporary storage place in memory called the Clipboard. Using Paste, you can insert the paragraph back into your notes wherever you like.
- Move the cursor to where you want the paragraph to be.
- Press Enter twice to make space for the paragraph you’re about to paste in.
- Press the up arrow twice to move the cursor to the top of the screen.
- Press Ctrl + V, or right-click and select Paste. The text you removed earlier will be added here.
- RootsMagic pastes the paragraph from the Clipboard into your notes. In a few simple steps, you moved an entire paragraph from one place to another.

A- 2 Sourcing alt + s

A-2-1 Add new source alt + a

A-2-1-1 Free Form

Enter information into the different tabs. See page 19 for adding media. Click OK

A-2-1-2 Source Templates

Select one that is the most like what the source is you are trying to add and complete the form. Be careful. These are not uniform among the different programs, although they are trying to accomplish the same thing.
Select the source you want. 
The Edit Source window opens
Enter your page number details (page number is where
I put the details)

**A-2-3 Delete alt + d**
Will delete the selected source from your Master Source List

**A-2-4 Memorize alt + m**
Memorizes the source citation. Make sure you add the
media first, if you have it to add

**A-2-5 Paste alt + p**
Link to all facts and people that are in the source by selecting that person’s name and/or fact by either
clicking on the source spot or alt + s. then pasting or alt + p.

### Sourcing Tips

- **Census (obtained from ancestry and other places):**
  - Use Cite an existing source if you have it already in your database
  - Add in page number: the place, name of household
  - Link a digital image of the record to the source. It will then show up on all the individuals
    the source is linked to.

- **Court Records (obtained from microfilm, abstracts, visits to court houses):**
  - Source Title is: County Court Records, Federal Court Records, or State Court Records.
  - Source Repository: County Courthouse, Federal Courthouse, State Courthouse
  - Add in page number: County, State, Type of Book or Record, Page or Record Number.
  - If it is a marriage or vital record put the name of the person and/or people.
  - Link a digital image of the record to the source. It will then show up on all the individuals
    the source is linked to.

- **Tombstones (obtained from cemetery visitations, books, findagrave, and other web sites):**
  - Source Title is: Tombstone or Cemetery
  - Source Repository: Cemetery.
  - Add in page number: Cemetery Name, Town, County, State (if website, name and date
    accessed)
  - Link a digital image of the cemetery sign to the source and it will show up on all the
    individuals the source is linked to.

  - **Link the individual tombstone images to the individuals.**

- **Vital Records (obtained from State Health agencies, familysearch.org, ancestry.com, and other
  web sites):**
  - Source Title is: Death Certificate, Birth Certificate, Marriage Certificate, Vital Record
    Index, and Church Records.
  - Source Repository: State Health Department, County Courthouse, Church Archive.
  - Add in page number: County, State, Year, Certificate #, Name(s) on Certificate.
  - Link a digital image of the record to the source. It will then show up on all the individuals
    the source is linked to.

  - **Births – Name is as on certificate, link to all names on certificate and birth date.**
  - **Deaths – Name is as on certificate, link to all names on certificate and all dates.**
  - **Marriages – Names in Citation text, husband & wife.**

- **Web Page:**
RootsMagic ver 7 – 1 – From Scratch
  o Source Title is: Web Page.
  o Source Repository: Internet.
  o Add in page number: Title of Web page and url, remember url’s can change or go away, Date accessed.
  o You can copy the webpage and link it in media.

➤ Books:
  o Source Title: Title of Book.
    - Complete the fields for Author/Originator, Publisher, Publisher Location, Publish Date, Call Number. Put the ISBN, Library of congress number in the comments.
  o Source Repository: Dallas Public Library, Grapevine Public Library, Family History Center, etc.
    - Complete address information for these repositories.
  o You can attach digital images of the pages of the book.

➤ Military Records
  o Source Titles: Military Service Record, Military Pension Record, Draft Record
  o Source Repository: NARA, familysearch, fold3
  o Add in page number: Name and War information
  o Link a digital image of the record to the source. It will then show up on all the individuals the source is linked to.

➤ Information from family members
  o Source Titles:
    - Completed Family Group Sheet.
      - Add in page number: name of person and date.
    - Correspondence
      - Add in page number: name of person and date.
      - Attach a digital image of the correspondence.

A-3 Share this fact alt + h

A-3-1 Add a person alt + a
Choose a person from the database opens RootsMagic Explorer. Select one person. See page 17.

A-3-2 Add multiple people alt +m
Opens RootsMagic Explorer with check boxes by names for you to select multiple people. Select them and click ok.
The name(s) appear in the window under person and role is default witness. To change the witness to something else double click on each name.
If you want to change the role to something else, click on the arrow to the right of Witness and click on Add new role type.

I add household member for the others listed in census records. Once it is added you can use it over and over again. Double click on each person to change their role. Click ok and the fact is shared with all the others listed.

**C. Adding people through facts**
The marriage fact

Add new person opens the add person box. See page 5. After you click ok you return to the original person’s edit person window and the cursor will be in the date box for the marriage. See page 6.

**D. Adding people through family view**
Note this is my preferred way of adding family units as it automatically sets up parent to child relationships and spouse relationships.
Click to add mother or father

Add new person will take you to the add person window and then the edit person window. See page 6. For adding multiple children, the best way is to do add child through the add menu or the people icon.
- Select Add child on either the menu bar or the icon
RootsMagic ver 7 – 1 – From Scratch

- Add new person, unless they are already in your database
  1. The add person box will open. See page 5
  2. Enter what you know and click ok.
  3. The Edit Person box will open. Add sources, etc. See page 6
  4. Click Close.
  5. Add Child box opens.
  6. Add another child
  7. Repeat the process until you have all children entered

- When this box opens after adding the last child click the no
- You are given to opportunity to Rearrange the children. See page 32.

E. Adding people from the add menu bar alt + a

There are other ways to add people to your database. From the menu bar is one of them.

Adding Individuals alt + i
You can add unrelated people to your database. This works well if you are doing a study database.

F. Adding Spouses alt + s
Select the person you want to add a spouse to. Alt + a, Alt + s OR Click on the wife box in the family view or add mother, father which is also adding parents. You can also add a marriage fact and add a person not already in your database.
Add marriage
Add a fact > marriage
Select existing one or click on add a new spouse
Add marriage date, place, alt + v or save
Alt + s or source button see page 9
Alt + o to close
If the person is already in your database select Existing Person. RootsMagic Explorer opens. See page 17.

If they are NOT in your database click on add new person or alt + a

Add Person – Spouse window opens. See page 5.

Adding Children

Select a parent to add a child to.
Add child alt + c
Add new person alt + a See page 5. or click alt + s for Existing person. See page 17.

Adding Parents

There are several ways to do this, it is personal preference as to what you do. They can be added through the pedigree view, family view, the add person icon or the menu bar. See page 12.

Add a Person from the icons

See above.
2 – DATA ENTRY ROUTINE

IN THIS SECTION, YOU WILL LEARN ABOUT:
A. Entering your information
B. Data Entry Tips
C. The Routine

A. Entering Your Information
There is more and more to include in the information you are gathering for your family history. RootsMagic is giving you more options and places to enter and preserve those records in a variety of ways and places.

- Build Your Family Tree—Enter facts in the edit person window by filling out the labeled fields, simply beginning with what you know.
- Source all the facts!
- Add pictures, documents and other digital media.
- Add stories, notes and transcriptions.

B. Data Entry Tips
- Be consistent the way you enter city, county, state. There is a place authority in the program now, however, it is far from complete. Cemeteries are not listed, but are sometimes on the map, so enter the name of the cemetery, city, county, state, United States
- Do not put in Dr, Capt or titles, there is another place to put that information. It goes under the Prefix.
- If you don’t know the exact date you can use:
  - About, the program will change it to Abt.
  - Before, the program will change it to Bef.
  - If you have two dates the program will USE Btw and put in both dates with a dash between them.

C. The Routine

C-1 Adding new people
See page 5 for opening the add person box.
1. Enter the given and middle name, tab
2. Enter the surname, tab
3. Enter sex, tab
4. Enter Prefix, Suffix, Nickname if you have any
5. Check or uncheck the living box
6. Enter the birth date, tab
7. Enter the birth place, tab
   If deceased,
8. Enter the death date, tab
9. Enter the death place, tab
10. Enter the Burial date, tab
11. Enter the Burial place.
12. Click ok or alt + o
13. The edit person box opens.
14. The name is selected.
15. Click on the sources button or alt + s see page 9 for more on sourcing
RootsMagic ver 7 – 2 – Data Entry Routine
16. Click on either add a new source or cite an existing source and complete the Citation
17. Click on the Media tab
18. Either add new media or add from gallery see page 18 for more on adding media
19. Click ok until you get back to the Citation Manager.
20. Click the memorize button or alt + m if you want this citation on multiple facts/people
21. Click the close button or alt + o
22. Click on a fact that you want to add this source to
23. You can either alt + s, alt + p, alt + o OR Click on the Sources button, paste button, close button.
24. Repeat this step on all facts/people you want this source on.
25. When you are through with that person click the close button on the edit person box.

C-2 Adding new facts to already existing people
Locate the person in RootsMagic Explorer.
Double click on them to open their edit person window.

1. Click on add a fact or alt + a
2. Select a fact out of the list.
3. Enter the date
4. Enter the place
5. Click save or alt + v
6. Click the source button or alt + s
7. Follow the above steps 15-25

C-3 Adding shared facts
1. Enter the fact, like a census record on one of the primary people.
2. Source it as above.
3. Click on Share see page 11
4. Click on each of the people shared with
5. Add the memorized source on the facts that were in addition to the shared fact, like name and birth date for census records.
3 – SOME ICONS

IN THIS SECTION, YOU WILL LEARN ABOUT:

A. Explorer  
B. Manual Merge  
C. Edit Multimedia

A. Explorer

Start typing, last name, given name. Note that there are birth and death years to help you with names that are the same or similar.

A-1 Prior alt + i
If you have multiple hits from your search, navigate backwards.

A-2 Name Find alt + m
If your search has multiple hits, way to page to the next hit

**A-4 Individual Edit alt + e**

The selected person:
- Person see page 6.
- Note see page 8.
- Sources see page 9.
- Media see page 7.
- ToDo see page 7.
- Address see page 7.

**A-5 Family Members Go to selected person alt + g**

Will go to the individual selected in that section and put them in the individual section.

**A-6 Select alt + s**

Will take you to the person selected in your default view.

**B. Manual Merge**

If you find you have the same person in your database, more than once. You can do a manual merge. Select one of the multiple entries. Click on the Manual Merge Icon (or you can right mouse click too! Remember there are multiple ways to do most things.) The following window will open:

Click on Select duplicate person alt + s and the RootsMagic Explorer Window will open (see above).

Find the other person of the multiple entries. Decide which one you want to keep and make them the Primary Person. Use the Swap alt + w if they are in the wrong order and click the Merge duplicate into primary alt + m.

**C. Edit Multimedia**

**C-1 Person Media alt + p**

Person media alt + p will open the selected person’s media window for media attached to that person.
C-1-1 Add new media alt + a

Select your media type.

Select your media location. If from disk, it will link to wherever you select the image. It does not copy or move it from the selected location. If you move it, the link will be broken. See page 21.

Type in a caption and add other information if you want/need to. Click ok. The media will be added to the individual or source depending on where you initiated the add.
Adding multiple images at a time

Once the window for adding media is open, you can add multiple images at a time by locating them in their housed location, selecting them all and dragging them into the adding media window.

Add from gallery alt + g
- Will generate thumbnails when you click on button or alt + g. This may take time depending on amount of linked media.
- You can view and search by file name.
- You can view and search by list.
- They are in alphabetical order.
- Find the one you want and click select and it will add it to the individual’s media.

View/Edit alt + v
- Opens the image.
There is some image manipulation possible.

**C-1-4 Properties alt + e**

Where you can put in a caption and more about the image in Descriptions.

**C-1-4-1 Tag media**

You can add comments to the media. If you want the image to be the Primary photo click and put a check mark in the box next to Primary photo for this person. Include in scrapbook for this person is checked in default.

**C-1-4-2 Edit tag**

Allows you to edit the above.

**C-1-4-3 Delete tag**

Deletes the tag.

**C-1-5 Remove Media alt + r**

Deletes the media link from the database, be very careful with this.

**C-1-6 Print**

Prints the selected media item.

**C-1-7 Tools**

Very important! If you move media this is where you re-establish the link for individuals.
C-2 Media gallery alt + M will take time to open

C-2-1 Add new media alt + a
See page 20.

C-2-2 View/Edit alt + v
See page 20.

C-2-3 Properties alt + e
See page 21.

C-2-4 Remove media alt + r
See page 21.

C-2-5 Tools alt + t
if you know where the media is, select A folder. Navigate to the folder and click on, but do not open the folder.

Click the ok button. If there is a lot, it will take some time to find and re-establish the links. You will see a progress bar as it looks and links.
4 – The Menu Bar

IN THIS SECTION, YOU WILL LEARN ABOUT:

A. Edit
B. Tools – Setting Default File Options

A. Edit alt + e

A-1 Person alt + p
See page 6.

A-2 Delete alt +d
Can delete whole families! Or just a person

A-3 Unlink alt + u
Can unlink person from wrong family groups

A-4 Rearrange alt + t
Sorts children by birth, spouses by marriage date. See page 32.

A-5 Swap Husband and Wife alt + s
Changes sex of corresponding names and spots in the trees
B. Setting default options

From Tools > File Options > General

Select:
1. Your Root Person, this is like the home person in FTM.
2. Which view you want to open to. Index is default.
3. How you want the nicknames to show up
4. If you want numbers after your names
5. Date format

Check box if you want surnames in uppercase
Check LDS support if you need it
5 – The Views

IN THIS SECTION, YOU WILL LEARN ABOUT:

A. Pedigree
B. Family
C. Descendants
D. People
E. WebSearch
F. Timeline

A. Pedigree

You can easily add parents in this view. See page 5. Double click on each individual to edit the individual. See page 6.

B. Family

You can easily add parents, spouses, and children in this view. See page 5 Double click on each individual to edit the individual. See page 6.
## C. Descendants

<table>
<thead>
<tr>
<th>Name</th>
<th>Sex</th>
<th>Born</th>
<th>Birth Place</th>
<th>Died</th>
<th>Death Place</th>
</tr>
</thead>
<tbody>
<tr>
<td>James Parks MITCHELL</td>
<td>M</td>
<td>13 Jun 1861</td>
<td>Dresden, Weakley, Tennessee, USA</td>
<td>16 Sep 1918</td>
<td>Clinton, Van Buren, Arkansas, USA</td>
</tr>
<tr>
<td>Mary Jane HENDRICKS</td>
<td>F</td>
<td>Aug 1859</td>
<td>Dresden, Weakley, Tennessee, USA</td>
<td>19 Jan 1919</td>
<td>Clinton, Van Buren, Arkansas, USA</td>
</tr>
<tr>
<td>George Thomas MITCHELL</td>
<td>M</td>
<td>16 May 1885</td>
<td>Martin, Weakley, Tennessee, USA</td>
<td>27 Oct 1935</td>
<td>Van Buren, Arkansas, USA</td>
</tr>
<tr>
<td>Nellie MITCHELL</td>
<td>F</td>
<td>Aug 1882</td>
<td>Martin, Weakley, Tennessee, USA</td>
<td>30 Apr 1954</td>
<td>Quitman, Cullman, Arkansas, USA</td>
</tr>
<tr>
<td>Luther S. MITCHELL</td>
<td>M</td>
<td>1912</td>
<td>Arkansas, USA</td>
<td>2 Oct 1959</td>
<td>Quitman, Cullman, Arkansas, USA</td>
</tr>
<tr>
<td>John HALL</td>
<td>M</td>
<td>16 Apr 1907</td>
<td>Arkansas, USA</td>
<td>2 May 1995</td>
<td>Arkansas, USA</td>
</tr>
<tr>
<td>Roy E. HALL</td>
<td>M</td>
<td>4 Nov 1899</td>
<td>Arkansas, USA</td>
<td>2 May 1988</td>
<td>Arkansas, USA</td>
</tr>
<tr>
<td>La Rue HOLLINDER</td>
<td>M</td>
<td>22 Feb 1909</td>
<td>Arkansas, USA</td>
<td>Dec 1967</td>
<td>Arkansas, USA</td>
</tr>
<tr>
<td>James Lawrence MITCHELL</td>
<td>M</td>
<td>21 Sep 1887</td>
<td>Martin, Weakley, Tennessee, USA</td>
<td>30 Apr 1954</td>
<td>Quitman, Cullman, Arkansas, USA</td>
</tr>
<tr>
<td>Faye Ernie MITCHELL</td>
<td>F</td>
<td>3 Sep 1902</td>
<td>Kentucky, USA</td>
<td>27 Oct 1959</td>
<td>Quitman, Cullman, Arkansas, USA</td>
</tr>
<tr>
<td>Nelson MITCHELL</td>
<td>M</td>
<td>1912</td>
<td>Arkansas, USA</td>
<td>20 Oct 1962</td>
<td>Arkansas, USA</td>
</tr>
<tr>
<td>Joseph MITCHELL</td>
<td>M</td>
<td>2 Nov 1910</td>
<td>Arkansas, USA</td>
<td>7 Dec 1992</td>
<td>La Habra, Orange, California, USA</td>
</tr>
<tr>
<td>Bevis MITCHELL</td>
<td>F</td>
<td>8 Jul 1914</td>
<td>Arkansas, USA</td>
<td>27 Jul 2009</td>
<td>Box Elder County, Box Elder, Iowa, USA</td>
</tr>
<tr>
<td>Meredith Frances MITCHELL</td>
<td>F</td>
<td>32 Feb 1914</td>
<td>Arkansas, USA</td>
<td>13 Apr 1982</td>
<td>Los Angeles, California, USA</td>
</tr>
<tr>
<td>Claudine Freeman MITCHELL</td>
<td>M</td>
<td>26 Nov 1916</td>
<td>Arkansas, USA</td>
<td>27 Feb 2000</td>
<td>Shelby, Tennessee, USA</td>
</tr>
<tr>
<td>Delia CLEMENTS</td>
<td>F</td>
<td>8 Jul 1914</td>
<td>Arkansas, USA</td>
<td>27 Jul 2009</td>
<td>Box Elder County, Box Elder, Iowa, USA</td>
</tr>
<tr>
<td>Wayne D MITCHELL</td>
<td>M</td>
<td>5 Apr 1918</td>
<td>Arkansas, USA</td>
<td>15 Jan 1998</td>
<td>Arkansas, USA</td>
</tr>
<tr>
<td>Richard F MITCHELL</td>
<td>M</td>
<td>1920</td>
<td>Arkansas, USA</td>
<td>25 Nov 2001</td>
<td>Myrtle Beach, Henry, South Carolina, USA</td>
</tr>
<tr>
<td>Mary Virginia MITCHELL</td>
<td>F</td>
<td>14 Feb 1903</td>
<td>Arkansas, USA</td>
<td>25 Nov 2001</td>
<td>Myrtle Beach, Henry, South Carolina, USA</td>
</tr>
<tr>
<td>Mary Jane MITCHELL</td>
<td>F</td>
<td>26 Jun 1898</td>
<td>Martin, Weakley, Tennessee, USA</td>
<td>17 Mar 1979</td>
<td>Home, Calhoun, Louisiana, USA</td>
</tr>
<tr>
<td>Willard NICHOLS</td>
<td>M</td>
<td>7 Feb 1898</td>
<td>Cullman, Cullman, Arkansas, USA</td>
<td>25 Mar 1979</td>
<td>Homer, Calhoun, Louisiana, USA</td>
</tr>
<tr>
<td>Mary Jan MITCHELL</td>
<td>M</td>
<td>11 Feb 1919</td>
<td>Clinton, Van Buren, Arkansas, USA</td>
<td>21 Nov 1995</td>
<td>Monroe, Ouachita, Louisiana, USA</td>
</tr>
<tr>
<td>Samuel Josiah TAYLOR</td>
<td>M</td>
<td>3 Apr 1898</td>
<td>Haynesville, Calhoun, Louisiana, USA</td>
<td>1 Feb 2007</td>
<td>Monroe, Ouachita, Louisiana, USA</td>
</tr>
</tbody>
</table>

### D. People

<table>
<thead>
<tr>
<th>Name</th>
<th>Sex</th>
<th>Born</th>
<th>Birth Place</th>
<th>Died</th>
<th>Death Place</th>
</tr>
</thead>
<tbody>
<tr>
<td>MITCHELL, Dennis R.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, Fiona A.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, D.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, E.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>M</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
<tr>
<td>MITCHELL, J.</td>
<td>F</td>
<td>13 Dec 1882</td>
<td>Missouri, USA</td>
<td>13 Dec 1956</td>
<td>Missouri, USA</td>
</tr>
</tbody>
</table>

### E. WebSearch

See page 36.
F. Timeline

<table>
<thead>
<tr>
<th>Age</th>
<th>Facts</th>
<th>Date</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Birth</td>
<td>1853</td>
<td>USA, Tennessee</td>
</tr>
<tr>
<td>3</td>
<td>Birth-Sibling</td>
<td>1856</td>
<td>Eliza C MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>4</td>
<td>Birth-Sibling</td>
<td>1857</td>
<td>William R MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>7</td>
<td>Birth-Sibling</td>
<td>1860</td>
<td>Lucetta MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>9</td>
<td>Birth-Sibling</td>
<td>1862</td>
<td>Joshua MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>11</td>
<td>Birth-Sibling</td>
<td>1864</td>
<td>James MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>11</td>
<td>Birth-Sibling</td>
<td>1864</td>
<td>Drusille MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>15</td>
<td>Birth-Sibling</td>
<td>1868</td>
<td>Ida MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>17</td>
<td>Birth-Sibling</td>
<td>1870</td>
<td>Mary A. MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>21</td>
<td>Birth-Sibling</td>
<td>1874</td>
<td>Benjamin F. MITCHELL USA, Tennessee</td>
</tr>
<tr>
<td>28</td>
<td>Death-Father</td>
<td>1881</td>
<td>Freeman W MITCHELL USA, Tennessee, Obion</td>
</tr>
</tbody>
</table>

F-1 Options

Timeline View Options

- Reverse place names
- Show place details
- Show shared events
- Show graphic timeline
- Show parent events
- Show sibling events
- Show child events
- Show spouse events
6 – MEDIA

IN THIS SECTION, YOU WILL LEARN ABOUT:
A. How media works within RootsMagic
B. Image naming tips
C. Filing System tips
D. The Media Gallery

A. How media works within RootsMagic
RootsMagic does not copy or move your media. It links to wherever you have it stored.

B. Image Naming Tips

Captions
- Keep them relatively short. If you have a family photo, name it by group and put the names of the people in the description area of the detail.
- If you have a group, like pension records, see Pension Record below.

Image Naming Tips
- Death Certificates – Name+Death Certificate
- Birth Certificates – Name+Birth Certificate
- Marriage Certificates - Surames(GroomBride)+Marriage Certificate
- Marriage Record – Surames(GroomBride)+Marriage Record
- Death Record – Name+Death Record
- Birth Record – Name+Birth Record
- Obituary – Name+Obit
- Will – Name+Will OR Name of County+WB+volume number+page number
- Deeds – Name of County+DB+volume number+page number
- Court Minutes – Name of County+CM+volume number+page number
- Probate Record – Name of County+PB+volume number+page number OR if loose papers
  Name+PR+001, etc
- Death Notice – Name+Death Notice
- Funeral Pamphlet – Name+Funeral Pamphlet
- Marriage Announcement – Surames(GroomBride)+Marriage Announcement
- Newspaper Articles – Name+Newspaper Article
- Family Bible – Name+Family Bible
- Pension Record – Name+PenR+001, etc
- Census (if you are not using ancestry, but have copies) – Name+census year
- Tombstones – Name+Tombstone
- Military Service Record – Name+MSR+001, etc
- Journal – Name of Journal+J+001, etc

C. Filing System Tips
There is no right or wrong way for organizing your media. Since RootsMagic links to where ever you have your media stored, you can organize it the way you want to. My system is to have a folder named to match my database (ie Shows = Shows Media) Within that folder I have files set up for census, vitals, military, land, probate, etc and because of the web interface a “NEW” folder. After I get all images uploaded to the web I need to track the new ones being added to the database. Once I have added 100 or so, I will update the database online with a new gedcom and upload the images in the
RootsMagic ver 7 – 6 – Media
“NEW” folder and get them linked. Once uploaded I can move them to their appropriate folders and perform a “fix missing links” function. A complete hierarchy chart will be coming soon.

D. The Media Gallery
From the camera icon, select Media Gallery. It may take a while to generate. But once it comes up, you can see all the media linked to your family file. See page 31.
7 - MISCELLANEOUS

IN THIS SECTION, YOU WILL LEARN ABOUT:
   A. Root Person
   B. Customizing add person form
   C. Adding new fact types
   D. Media album
   E. Children out of order
   F. Multiple Spouses out of order
   G. Ah oh
   H. Take care of your database

Root Person
This is the person you want the whole database to relate to. You can change this person

Go to Root Person
Search > Go to Root Person

Setting Root Person
See page 24

Customizing add person form
Click add fact to form or alt + a. See page 6.

Adding new fact types
From any add fact click the design new fact or alt + n
**Children out of order**

In the Family View click on the or from the Edit menu select Rearrange > Children

You can sort by birth order if you have entered birth dates. If you don’t have dates, but have the order you can rearrange them with the move up and down arrows.

**Multiple Spouses out of order**

Select the person that has multiple spouses. From the Edit menu select Rearrange > Spouses

You can sort by marriage date order if you have entered those dates. If you don’t have dates, but have the order you can rearranged them with the move up and down arrows.

**Ah-oh**

⚠️ we sometimes miss enter things. This is the warning icon. It will tell you dates don’t work with parentage, you didn’t enter the sex. The list and criteria are in Tools>File Options>General>Problem Search.

Double click on the icon.

You can say it isn’t a problem. Edit person will take you to the edit person window and you can fix the problem. Don’t forget to save. When you close all the windows the error icon should be gone.
Take Care of your Database
From the File menu > Database Tools.

Start at the top and do each one. Do this on a regular basis.
8 – WEB HINTS AND WEB SEARCH

IN THIS SECTION, YOU WILL LEARN ABOUT

A. WebHints
B. Search with the WebSearch option for the selected site
C. Manage different search providers
   a. Use external browser
   b. Auto-search within RootsMagic Web Browser
D. Saving images in Chrome
E. Saving images in Firefox
F. Saving images in Edge
G. Saving images in Internet Explorer

A. WebHints

The Light Bulb

Click on each provider one at a time and review the hints.

A-1 Familysearch.org

Click on any link and the below window will open in your default browser.
Review the hint. Save the digital image(s) if any. Source it to your person and add the media.

**A-2 Findmypast.com**

Click on Review.

Accept or reject
Click on back to results, go to next item.

A-3 My Heritage.com

B. WebSearch

C. Manage different search providers

You can add different websites from their search providers to show up in your drop down list by clicking on the Manage Search Providers at the bottom of the drop down list. Click the Custom Search Providers tab to add your own.

C-1 Use External Browser

The one selected opens in your default browser. It is partially populated with information, but not completely.

C-2 Use Auto-Search

Click on search provider.
Right mouse click on link to open in your default browser.

**D. Saving in Chrome**

Click the arrow next to the downloaded image
Select Show in folder
Right mouse click on the highlighted image and rename the image to what you want it to be.
Move the renamed image to where you want its permanent location to be.

**E. Saving in Firefox**

Select save file. It will go in your download folder. Find it, rename it, move it to where you want its permanent location to be.

**F. Saving in Edge**

Select save file. It will go in your download folder. Find it, rename it, move it to where you want its permanent location to be.
It will be in your download folder. If you click on open folder the folder will open with the image highlighted. Right mouse click on the image, rename it. Move the image to where you want its permanent location to be.

G. Saving in Internet Explorer

You want to click the arrow by the save and select **Save as** and a windows’ save as window will open. You can save where you want to save the image. If you are saving images and then immediately linking them to your family tree database save them someplace where you can go and delete them easily, like to the desktop. If you are saving them in family files, navigate to where you want to save it. Remember where you put it for access later if you aren’t working with your data base, just saving images. Firefox and Chrome Browsers save them in downloads and you have to go there to rename them and then move them to where you want them to be permanently.
9 – KEYBOARD SHORTCUTS

IN THIS SECTION, YOU WILL LEARN ABOUT
A. General Keyboard Shortcuts
B. Windows Keyboard Shortcuts
C. RootsMagic Keyboard Shortcuts

A. General Keyboard Shortcuts

➢ If you make a mistake, use the left-directional arrow key to move the cursor back to the left, and use the Backspace key to delete the incorrect characters.
➢ The Backspace key deletes characters as it moves the cursor to the left. If you need to move the cursor back to the right, press the right-directional key.
➢ The left and right arrow keys are usually on the right side of the keyboard; sometimes they’re part of the numeric keypad (the rectangular arrangement of number keys—not the ones across the top of your keyboard). If you press the arrow keys but you get numbers on the screen, press Num Lock to put the numeric keypad into cursor-moving mode.
➢ You can also fix mistakes by simply typing over them with the correct information. To do so, highlight the area that is wrong and start typing the correct information.

B. Windows Keyboard Shortcuts

Function Keys
F1 - Get Help or visit Microsoft Office Online.
F2 - Move text or graphics.
F3 - Insert an AutoText
(AutoText: A storage location for text or graphics you want to use again, such as a standard contract clause or a long distribution list. Each selection of text or graphics is recorded as an AutoText entry and is assigned a unique name.)
F4 - Repeat the last action.
F5 - Choose the Go To command (Edit menu).
F6 - Go to the next pane or frame.
F7 - Choose the Spelling command (Tools menu).
F8 - Extend a selection.
F9 - Update selected fields.
F10 - Activate the menu bar.
F11 - Go to the next field.
F12 - Choose the Save As command (File menu).

SHIFT + Function key
SHIFT + F1 - Start context-sensitive Help or reveal formatting.
SHIFT + F2 - Copy text.
SHIFT + F3 - Change the case of letters.
SHIFT + F4 - Repeat a Find or Go To action.
SHIFT + F5 - Move to the last change.
SHIFT + F6 - Go to the previous pane or frame.
SHIFT + F7 - Choose the Thesaurus command (Tools menu, Language submenu).
SHIFT + F8 - Shrink a selection.
SHIFT + F9 - Switch between a field code and its result.
SHIFT + F10 - Display a shortcut menu.
SHIFT + F11 - Go to the previous field.
SHIFT + F12 - Choose the Save command (File menu).

CTRL + Function key
CTRL+F2 - Choose the Print Preview command (File menu).
CTRL+F3 - Cut to the Spike
(Spike: A special AutoText entry that stores multiple deletions. Microsoft Word appends one item to another until you paste the contents as a group in a new location in your document. You can also use the Microsoft Office Clipboard to get the same result.)
CTRL+F4 - Close the window.
CTRL+F5 - Restore the document window size (for example, after maximizing it).
CTRL+F6 - Go to the next window.
CTRL+F7 - Choose the Move command (title bar shortcut menu).
CTRL+F8 - Choose the Size command (title bar shortcut menu).
CTRL+F9 - Insert an empty field.
CTRL+F10 - Maximize the document window.
CTRL+F11 - Lock a field.
CTRL+F12 – Choose the Open command (File menu).

CTRL + SHIFT + Function key
CTRL+SHIFT+F3 - Insert the contents of the Spike
(Spike: A special AutoText entry that stores multiple deletions. Microsoft Word appends one item to another until you paste the contents as a group in a new location in your document. You can also use the Microsoft Office Clipboard to get the same result.)
CTRL+SHIFT+F5 - Edit a bookmark.
CTRL+SHIFT+F6 - Go to the previous window.
CTRL+SHIFT+F7 - Update linked information in a Microsoft Word source document.
CTRL+SHIFT+F8 - Extend a selection or block (then press an arrow key).
CTRL+SHIFT+F9 - Unlink a field.
CTRL+SHIFT+F11 - Unlock a field.
CTRL+SHIFT+F12 - Choose the Print command (File menu).

ALT + Function key
ALT+F1 - Go to the next field.
ALT+F3 - Create an AutoText
(AutoText: A storage location for text or graphics you want to use again, such as a standard contract clause or a long distribution list. Each selection of text or graphics is recorded as an AutoText entry and is assigned a unique name.)
ALT+F4 - Quit Microsoft Word.
ALT+F5 - Restore the program window size.
ALT+F6 - Move from an open dialog box back to the document for dialog boxes such as Find and Replace that support this behavior.
ALT+F7 - Find the next misspelling or grammatical error. The Check spelling as you type check box must be selected (Tools menu, Options dialog box, Spelling & Grammar tab).
ALT+F8 - Run a macro.
ALT+F9 - Switch between all field codes and their results.
RootsMagic Keyboard Shortcuts

RootsMagic has additional help tools.

Mouse over Help—pops up a small box when you hold your mouse pointer over buttons or fields for more than two seconds. It tells you what the icon or button is for. When you move your mouse away from the icon or button the window closes automatically.

Some computer keyboards have a row of numbered keys across the top called function keys or F-keys. See pages 359-361 of the RootsMagic 7 Book.